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About the Workshop Booklets Understanding the Symbols in This Booklet

Throughout this booklet, you'll come across information that deserves
special attention—that’s the reason it's labeled with one of the following
symbols.

Roland’s SonicCell is designed for modern musicians. Using USB, It adds a
huge set of sounds to your digital audio workstation (or “DAW”") without
adding to your computer’s workload. It’s also an audio interface that can get
signals from mics, instruments, or other devices to DAW tracks for recording. ,
SonicCell’s Editor software allows you to program SonicCell from within your )) A note is something that adds information about the topic at hand.
DAW. Onstage, its compact size also makes SonicCell the ideal companion

for a laptop DAW, letting you perform and sing along with recorded tracks.

Or use it to play back sequences and audio files from a USB memory stick. ,{ A tip offers suggestions for using the feature being discussed.

Each SonicCell Workshop booklet focuses on one SonicCell topic, and is

intended as a companion to the SonicCell Owner’s Manual. This booklet ’ Warnings contain important information that can help you avoid
requires SonicCell O.S. Version 1.11 or higher. You can download the latest o possible damage to your equipment, your data, or yourself.

SonicCell O.S. for free from www.RolandUS.com.

About This Booklet Configuring SONAR to Work With SonicCell
This booklet contains instructions for using SonicCell with Cakewalk’s You've got three things to prepare in SONAR for using it with SonicCell:
SONAR 7. (What we'll cover also applies to SONAR 6.) First we'll discuss SONAR'’s audio system, the SonicCell Editor, and SONAR’s MIDI system. The
recording MIDI tracks in SONAR using SonicCell’s synth sounds. Next, we'll following sections walk you through these three operations.
talk about SonicCell as as an audio interface, telling you how to record both
live audio and SonicCell’s synth sounds as audio tracks in SONAR. Setting Up SONAR for SonicCell Audio

/ When you first launch SONAR, you’ll encounter warnings about not
)) having any MIDI outputs and inputs selected. Click Continue with No
MIDI Output and then Continue with No MIDI Input for now.

Here's how to set up SONAR so you can hear what you're
doing through SonicCell. We'll also prepare SONAR to
record SonicCell’s synth sounds and any live audio you're L AcTLeam

sending through it: P T Cogrtn

Audio.., %
Audio Meter Settings.

1 After launching SONAR, select Audio.. from

We'll assume you've installed and know how to operate SONAR—otherwise, the Options menu to open the Audio Options s

consult SONAR’s built-in documentation in its Help menu. We'll also assume window, and then click the Advanced tab. - '
you've read the Using SonicCell with a DAW and Using SonicCell as an Audio 2 Set Driver Mode to ASIO, and click OK, as shown bt
Interface Workshop booklets, that both SonicCell and your computer are in the screenshot on the next page. o

Drum Map Manager.

hooked up and turned on, and that you're listening through SonicCell.

Henu Edtor ..
Menu Layouts »
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Audio Options - ASI0 X
| General | Advanced | Diivers | OK
[JEnable Read Caching [T Enable Wiite Caching
Playback 170 ) - Record /0 |
Buffer Size (KB - Buler Size (KB

Piapback an Recording

Diverbode | v O Tigver Fresuheel

(Bestwhen sound card has &
Dithering: Tiangular v word clock input |
@ Full Chase Lock

(Best when chasing to MIDI
Use Muliprocessing Engine time code.]

Lise MMCSS (aincows Vista]
] Play Effect Tails After Stopping
L] Aways Dpen Al Deviess

L] Remove D Ofset During Fecord
Record Pre-gllacate 5
i S I

Record Latency Adjustment (samples)

[T Share Drivers With Other Programs

Tiving Offset frsec) (0000 |2/

Device: | Roland SonicCel (1in, 1 oul ~

MarualOffsel 0|/ [214510 Repoted Latency: 165

Windows asks you to relaunch SONAR for your new settings to take
effect.

SONAR 7 Producer Edition

§ ) Changes wilnot take effect untilthe nest time you start the program. To Mmake them take effect now, please chaase Exit from the File menu, then
stark the program again.

Click OK, quit SONAR, and then relaunch the program.

After SONAR has restarted, close the Quick Start window and return
to Audio... in the Options menu.

In the Audio Options General tab, set Playback Timing Master to 1:
Roland SonicCell:OUT 1, and check to make sure the Record Timing
Master is also set to the same thing, as shown here.

Audio Options - ASIO 3]
1 Playback Timing Master | 1: Raland SonicCell OUT L v Cancel
( Pecord Timing Master Tl Help
it [ B4-bit Double 3
StoreoPanning Lave | Q0B canter, /oo taper, corstantporer |
Dim Selo Gairt O-6de @128 O -188

Sawping Rate; (44100 v
Bufers in Plagback Queve: |© |

BufferSiges  ———————————————— Bmec

Fast Safe

4510 Parel,

Set Sampling Rate to SonicCell’s sampling rate.

o

If you select a sampling rate other than the one SonicCell is using,
you'll see a message telling you that’s not possible, and that SONAR's
sample rate’s been reset to match SonicCell’s.

SONAR 7 Producer Edition

‘2 “The default audio Format is not compatible with ane or more sound cards. It has been reset to 44100 Hz (32 bit), a5 suggested by the driver.

To use another sampling rate, change SonicCell’s sample rate first as
described in the Using the SonicCell with a DAW Workshop booklet.

If you want to work on a project in which audio’s already been
recorded, first set SonicCell’s sample rate to match the project’s.

Click the Drivers tab, and checkmark 1: Roland SonicCell IN L and 1:
Roland SonicCell OUT L as input and output drivers, respectively, if
they're not already selected.

Audio Options - ASIO 5]
| General | Advanced| Diivers | Ce ]
Checksuncheck an enti to enable/disable the dirver Ca)
Cirtptie b
| lnputDivers — Hel
Friendly Name Diver Mame
Roland SonicCell IN L Roland SonicCell IN L

Friendyy Name Diiver Name
Roland SoricCel OUT L Roland SonicCell OUT L

[T Use fiendy names to represent audio diivers.

Click OK to exit the Audio Options window.

When you close the Audio Options window, Windows once again
tells you that you'll need to relaunch SONAR.

Quit and then relaunch SONAR.



Setting Up SONAR to Use the SonicCell Editor

In SONAR you'll find the Cakewalk Plug-In Manager with which you register
the SonicCell Editor as a plug-in for use with SONAR. Here's how:

1

2
3
4

From SONAR’s Tools menu, select Cakewalk Plug-in Manager.
In the VST Configuration area, click Options.
In the Cakewalk VST Scan Paths window, click Add...

Navigate to your C drive, the Program Files folder—presuming you
used the default install location—highlight the Roland folder, and
click OK.

Back in the Cakewalk VST Scan Paths window, click OK—SONAR scans
the displayed folders and displays all of its found plug-ins in the
Cakewalk Plug-in Manager window. (You'll see the SonicCell Editor if
you click VST Instruments (VSTi) in the left-hand pane.

Click Close to finish registering the SonicCell Editor.

Setting Up SONAR for SonicCell MIDI

In the following sections, we'll assume a couple of things about the way
you're working. We'll assume

you've got SonicCell in Performance mode—using SonicCell’s PRST 01
Seq: Template performance to start with.

you've connected a MIDI controller to SonicCell's MIDI IN jack—and that
you've turned on SonicCell’'s USB-MIDI Thru parameter, as described in
the Using SonicCell with a DAW Workshop booklet.

Here's how to get SONAR to exchange MIDI data

with SonicCell: P R
. ControllersfSurf,

1 In SONAR, select MIDI Devices... from the i
Options menu to open the MIDI Devices PEY Tool Corfiguration. ..
window. fudo.

. Audio Meter Settings...

2 In the Inputs and in the Outputs panes,

Global,..,

select 1:Roland SonicCell so it's checkmarked Broject...
as shown here: Colrs..

Teors v

i Key Bindings. ..
MIDI Devices. -
E‘ Inttialization File. .

Check /uncheck to select/deselect MIDI inputs and outputs.

Cik o afecy e o i .

| nputs ______________________________ N ; ;

v hon-Destructive MIDI Editing
Friendly Name Device Mame
Drum Map Manager...

1:Roland SonicCell 1:Roland &onicCell

Menu Editar...

Menu Layouks 4

Friendly Name: Device Name
[ Microsoft 65 Wavetable .. Microsoft GS '/ avetabls 5
1:FRioland SanicCel 1:Roland SonicCel

Move Checked Devices to Top

] Use fiiendly names ta represent MIDI devices.
‘wamn about no MIDI devices

Click OK.

From the Options menu, select Global... to open the Global Options
window.

Make sure that Always Echo Current MIDI Track is checkmarked so
that your SonicCell patch plays as you sequence, and click OK.

SONAR is now set up to exchange MIDI data with SonicCell.



Creating a SonicCell Editor Track

You'll need to do this first so you have an easy way to
select patches for your SonicCell synth tracks.

1 Select an unused audio track in your project,
or add a new one.

2 Click the track’s Restore Strip Size button to
display its settings.

[Track 1 |

Insert dudi Track [%
Insert MIDI Track
Insert Mltiple Tracks...

Insett Track Eolder

Insert From Track Template  *
Delete Track

[te
Archive
Solo

Arm

Track Properties. .

\Widget Tab Management..,

/» If the new track doesn’t look like what you see here, click the All tab
at the bottom of the tracks area to reveal all of the track’s settings.

3 Right-click in the track’s FX area
and select VST SonicCell Editor
from the DXi Synth menu.

Bypass Bin

audo Fx

4 The SonicCell Editor launches oft syt
and retrieves SonicCell’s B reet
current settings.

Plug-in Layouts r

Alien Connectians Revalver SE
Cakewalk TT5-1

Cyclone

DreamStation D2

Pentagan 1

PsYN I

Roland Groovesyrth

RAP

Cakemalk »
Roland (SoricCell Editor ¥ST) E

/» Changes you make to SonicCell using the Editor affect SonicCell’s
current performance, or—if you’re in Patch mode—its current patch.

5 To close the Editor window at any time, click its Minimize button—it
then appears as a small launcher above the Task bar. To re-open it,
click the launcher’s Restore Up button.

Once you’ve set up the editor, you can click its track’s Minimize Strip
button to shrink the track vertically.

We recommend renaming the track “Editor” to make it easy to locate
as your arrangement grows in complexity.

Using the SonicCell Editor
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Mode-selection buttons

You'll find detailed instructions for using the SonicCell Editor in its manual,
which you can display by clicking the Help button in the SonicCell Editor
window. What follows here are some quick instructions to get you started.

Everything you set up in the SonicCell Editor is automatically saved
in your SONAR project. When you reload the project, the Editor
automatically sets up the current performance in SonicCell to match.



Selecting a Patch for a Part

You choose each patch you want to use in SONAR by selecting it for the part
that a SONAR MIDI track is configured to play. Here's how:

1

Click the desired part’s number in the PARTS area of the Editor
window.

Select a patch for the part using the controls in the patch-selection
area, circled in red on the previous page. To select a patch by:

*  memory location—click the PATCH NAME parameter’s popup
arrow to reveal SonicCell’s patches organized by their memory
locations.

e category—click the CATEGORY parameter’s popup arrow to
reveal SonicCell’s patches divided into categories.

You can select performances stored in SonicCell using the PERFORM
NAME popup located above the part-selection area.

Digging Deeper

The SonicCell Editor lets you change the current performance’s sounds in a
range of ways. The mode-selection buttons to the left of the Editor window
determine the parameters you see and can edit at any given time. They're
divided into the following sections:

SYSTEM—The buttons in this area allow you to set SonicCell’s global
behavior, and also get quick access to its input effect, a handy thing
when you're recording live audio through SonicCell.

PERFORM EFFECTS—These buttons edit the performance’s effect setup.

PERFORM—These parameters allow you to control the way each part
plays its patch, and lets you add effects to the patch.

PERFORM PATCH—These parameters allow you to dig right inside a
part’s patch in order to edit it down to its most basic characteristics.

Before using the PERFORM PATCH buttons, be sure to select the part
that plays the patch you want to edit. You do this by clicking the part’s
number in the part-selection area at the top of the window.

Sequencing with SonicCell Patches

1

Open the project you want to work on, or create a new one.

In SONAR, you can identify MIDI tracks by the MIDI jack
icon to the left of a track’s name.

Insert Audio Track

Insert MIDI Track
Insert Multiple Tracks. .. k

Insert Track Folder

If no unused MIDI tracks are available in the
project, right-click below the project’s tracks,
and select Insert MIDI Track from the popup.

Insert From Track Template  »

Click the track you want to use, and click its
Maximize Strip button to reveal its settings.

Delste Track

Mute
Archive
Salo !

arm

Track Properties ..

Widget Tab Managsment...

Click the track’s Input popup arrow and select 1:Roland SonicCell -
Ch. 1 from the popup menu.

Click the track’s Output popup arrow and select 1-1:Roland SonicCell
from the popup menu.

Set the Channel parameter to the number of the SonicCell part
whose patch you want to sequence.

Your track’s settings should look like this:

We've selected
MIDI Channel 1
to play the patch
belonging to
Part 1.




If you haven’t yet selected a patch on SonicCell to play from this track,
)} use the SonicCell Editor to assign the desired patch to the part you
‘ want to use. Once you’ve done that, return to the MIDI track you’ve
been setting up.

7 When you play your controller with your new track selected, you
should hear the desired patch play in SonicCell.

8 Record your SonicCell track as you would any other SONAR track—
when you play it back, you'll hear its SonicCell patch play. (You can
shrink the track vertically by clicking its Minimize Track button once
you're done with it.)

9 Repeat Steps 2-8 for other SonicCell tracks you want to sequence.

At this point, your track is sequenced, and you’ll hear it each time you
)} play your project, including when you edit the track. However, the
i sound is still coming from SonicCell itself—it hasn’t yet been recorded
as an audio track in SONAR. We’ll get to that in the next section.

Recording Audio from SonicCell in SONAR

: If you haven’t yet read the Using SonicCell as an Audio Interface
)? Workshop booklet, read it now before proceeding. SonicCell offers lots
of audio-interface options you’ll want to know about.

Setting Up an Audio Track for Recording

Selecting Audio to Record
1 Open the project you want to work on, or create a new one.

' You can spot audio tracks by the waveform icon to the left
of a track’s name.

If no unused audio tracks are available in Insert Audio Track %
the project, right-click below the project’s eI Track

Insert Multiple Tracks...

tracks, and select Insert Audio Track from the Insert Track Foider

popup. Insert From Track Template  »
Delete Track

Click the audio track to select it, and then its ke

the Restore Strip Size button to reveal the Archige

track’s settings. o

Track Properties...
Track 5 : Widget Tab Management...
G

Click the track’s Input popup arrow and select the SonicCell output
from which you want to record. To record

® a mic or instrument connected to SonicCell’s Neutrik input jack—
select Left Roland SonicCell IN L.

e astereo device connected to SonicCell’s Neutrik and (LINE) R input
jacks—select Stereo Roland SonicCell IN L.

e aSonicCell synth patch in stereo—select Stereo Roland SonicCell
IN L.

Make sure the track’s Output is set to Roland SonicCell OUT L. When
you're done, the track’s settings should look like this:

Track 5




Turn Off Software Monitoring

1 If the track’s channel strip isn't visible, click the track in the Track
window.

2 Click the channel’s Input Echo button so
it’s not lit.

As we noted in the Using the SonicCell with a DAW Workshop booklet,
you do have the option of listening through SONAR if you want to hear
its effects as you record. However, unless you need to hear one of
the SONAR’s effects while recording, we recommend listening through
SonicCell since you may encounter latency listening directly through
SONAR.

3 Record your track as you would any SONAR audio track. (As with
a MIDI track, when you're ready to move to another track, you can
reduce the size of the track by clicking its Minimize Track button.)

4 Repeat the steps in these last two sections for any other audio tracks
you want to record.

Before Recording: SonicCell Audio-Recording Strategy

Since SonicCell can simultaneously be the source of synth sounds and your
live audio, a little thought needs to be given to making sure you're only
recording exactly what you intend to record on any given track.

When you want, for example, to record a single SonicCell synth sound on
its own track, you don't want your other synth sounds to also find their way
onto that track. Likewise, when you want to record a vocal or other live audio
signal, you don’t want to wind up with your synth tracks recorded on that
live audio track.

Here’s what you have to do.

When you want to record a single synth track as a SONAR audio track

mute any other SonicCell synth tracks you have in the song by
clicking their Mute buttons to light them, or mute their parts in
the SonicCell Editor.

If you've connected a mic, instrument, or other device to one of
SonicCell’s inputs, disconnect it until you're ready to record its
audio onto a SONAR track.

When you want to record live audio as a SONAR LE audio track, you can use
either of two methods:

Ifyou need to hear your SonicCell synth tracks as you record—send
your live audio through SonicCell’s input effect, and then set the
TO COM parameter on the In/Out Routing screen to Input FX.

If you don't need to hear SonicCell synth tracks as you record—
mute them in SONAR LE by clicking their Mute buttons to light
them, or mute their parts in the SonicCell Editor.

The End

We hope you've found this workshop helpful. Keep an eye out for other
SonicCell Workshop booklets available for downloading at www.RolandUS.
com.
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